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What do I need to know to use Data Transfer?
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© 2003 IBM Corporation

Uses the iSeries database server to transfer data to and from DB2 
database files and iSeries source physical files

Provides an SQL-like interface to allow full file SELECT or customized 
queries including joins, sorting, and record grouping

Capable of transferring data to and from many popular PC file types 
including ASCII Text, CSV, Excel types, Tab-Delimited Text, Lotus 
.WK4, and others

Provides access to iSeries file members

Transfers may be run interactively, in batch mode, programatically, or 
directly from Microsoft Excel

Overview of Data Transfer
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Accessing other types of files on the iSeries

Data Transfer is limited to tranferring source physical files and data 
physical files to PC file types and PC file types to the source and data 
physical files on the iSeries.  Transferring other types of files to and 
from a PC and the iSeries requires using other methods.  Some other 
types of files that reside on the iSeries are stream files or flat files such 
as those stored in the Root or NetWare portions of the iSeries 
Integrated File System.  These files may be accessed using the 
methods listed below.

iSeries NetServer through 'shares'
iSeries Navigator Integrated File System (IFS) support
File Transfer Protocol (FTP)

Overview of Data Transfer
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Where to find Data Transfer
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The iSeries Access for Windows Folder

The Data Transfer From iSeries and 
Data Transfer To iSeries applications 
may be started by double clicking on 
their icon in the IBM iSeries Access for 
Windows folder on your desktop.

Where to find Data Transfer
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Another way of accessing the Data Transfer function is through the iSeries Access menu or the iSeries Access program group.

To access Data Transfer from the menu, click on Start, Programs, IBM iSeries Access for Windows, and then either Data Transfer From iSeries or Data Transfer To 
iSeries  Doing this will bring up a new transfer request that is ready for your input.

If you chose to create a program group at the end of installing Client Access, you can also open Data Transfer From iSeries or Data Transfer To iSeries from the IBM 
iSeries Access for Windows program group.

After the Data Transfer window is open, you can also load existing requests by selecting File - Open, or by choosing a request from the MRU list in the File menu.

Notes: Starting Data Transfer from the Client 
Access Folder
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Transfer request files in Windows Explorer

Transfer requests may be opened by double clicking on their icon in the Windows 
Explorer.  By specifying the Detail view from the View menu, the Transfer request type is 
displayed in the right pane of Explorer.

Where to find Data Transfer
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If you have existing Data Transfer requests, you can also invoke Data Transfer from the Windows Explorer application.

To do this, simply open the Windows Explorer application and locate your Data Transfer requests.  Once located, double click on the Data Transfer request you would 
like to work with.  If you double-clicked on a .DTF or .TTO file, Data Transfer From iSeries will be loaded.  If you double-clicked on a .DTT or .TFR file, Data Transfer To 
iSeries will be loaded.  In iSeries Access for Windows .DTF and .DTT transfer requests can be setup to execute when they are opened from the Windows Explorer. The 
process of setting up "autorun" transfer requests is covered in a later section.

Notes: Data Transfer from Windows Explorer
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Data Transfer from a PC5250 Display Session

Selecting 
the send or 

receive 
options from 
the Actions 
menu will 
start Data 

Transfer To 
or From 
iSeries

Where to find Data Transfer
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Data Transfer is available from the PC5250 emulator menu items From the emulator menu, select Receive File From Host under the Actions menu item.  This will bring 
up a Data Transfer from iSeries window.  Fill in the fields with the appropriate values and run the transfer request.

Transfers to the iSeries can also be performed through the emulator menus.  To do this, select Send File To Host under the Actions menu item.

If you prefer the file transfer mechanism of the emulator that was available in previous releases, refer to Informational APAR II10202 to change the menu items to call 
that version of file transfer.

Notes: Data Transfer from PC5250 Display Session
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Data Transfer wizards from the Desktop

A new 
transfer 

request can 
be created 
easily by 

right clicking 
on the 

desktop and 
selecting 

New-> Data 
Transfer 

From AS400 
or Data 

Transfer To 
AS400

Where to find Data Transfer
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Data Transfer wizards from the Desktop

New Data Transfer 
From AS/400

The Data Transfer desktop wizards may be used to simplify 
the process of creating transfer request files

Where to find Data Transfer
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To create a new Data Transfer request, users can click the right mouse button on any "open" area on the desktop and select Data Transfer From AS400 under the New 
menu item.

A Data Transfer From iSeries wizard will be displayed.  This wizard will go through a set of pages to assist in setting up a transfer request.  The pages will prompt for 
System name, iSeries database file, PC output device, and allow for selecting more advanced formatting options.  This function is also available for Data Transfer To 
iSeries.

To invoke the wizards manually, enter:

For Data Transfer to iSeries   
CWBTF /s [optional file.dtt]

Or

For Data Transfer from iSeries
CWBTF /r [optional file.dtf]

Notes: Data Transfer From iSeries Wizard
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Running Data Transfer from the command line

Batch
RTOPCB
RFROMPCB 

Wizards
CWBTF /R <filename>
CWBTF /S <filename>

Data Transfer Graphical Interface
CWBTF /T
CWBTF /F

CWBTF <filename>

Where to find Data Transfer
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Data Transfer From iSeries

Transferring data from your iSeries
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The Data Transfer From iSeries main panel
Use Data Transfer From iSeries to create new transfer request files and to 
transfer data to the PC.

1
2

3

4 5

6
7

1.Enter or select the name of the 
iSeries to transfer data from.

2.Enter or browse for the file/files 
to transfer to the PC

3.Specify the fields to transfer, 
conditions on data, and sort 
order.

4.Select the output device.
5.Set specific options for the 

output device.
6.Set data options such as date 

and time formats and decimal 
separator.

7.Transfer data to your PC.

Data Transfer from iSeries
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Steps to perform a simple download to a file

1) Start by selecting a system name from the system list.

2) Either enter the library/file you want to transfer to your PC, or select Browse to find the library/file you want to transfer.  If the file exists in a library that is not in your 
library list, type in the library name (no slash) and hit Browse.  The Browse dialog will now contain a list of files in the Library you selected.  Beginning with V3R1M3, 
you can also add a library to the library list (up to 32 libraries).  This will be covered in more detail later. 

3) Select File as the PC Output Device.  The default file type is ASCII text.

4) Browse for an existing PC file that you want to transfer the data into, or enter the name of a new file in the PC file name field.

5) Select Transfer data from iSeries.  This will transfer the entire database file to the PC.

Notes: Data Transfer from iSeries
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Steps to perform a simple download to a file (continued)

6) If you will need to reuse this transfer request, select Save under the File menu.
 
Other download options:

File Options - You can open and existing request, save the current request, or load a request from the MRU list.

Properties - You can change conversion settings, configure your library list, set security options, and modify other transfer request settings.

Format Options - You can set options such as Date/Time formats, Decimal separator, and National Language specific sorting.

iSeries Data Options - You may set up requests to query for specific data.

PC Output Device - You can transfer data to: Display, File (many different formats), HTML, or Printer.

Notes: Data Transfer from iSeries (continued)
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The File Menu - working with transfer requests

Options on the file menu provide a means to work with stored 
transfer request files.

Data Transfer From iSeries

File menu options 
include:

Creating a new request
Opening an existing 
request
Saving the current 
request
Saving the current 
request under a different 
file name
Setting request 
properties
Loading a recently used 
request
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Data Transfer has a menu bar.

The main function of menu bar is the File menu.  This menu offers items such as New, Open, Save, Save As.  These functions make it easier to create, modify, and 
save transfer requests.

The File menu also contains a Most Recently Used (MRU) list of the last four transfer requests. 

Lastly, and perhaps most importantly, is the Properties option under the File menu.  This allows users to control conversions, library lists, display options, use of 
secure sockets, auto-run of the request and more.  

For those of you that used CWBTFR.INI to control Data Transfer in the past, the Properties option replaces the INI file.  This allows you an easy to use mechanism to 
control these settings on a request basis.  The INI file is still used to "prime" newly created requests.

Notes: Data Transfer File Options
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Startup Options

Startup options control how transfer requests behave when 
they are opened via the Windows Explorer or the CWBTF 
command on the command line.

By enabling 'Run transfer request 
automatically' and 'Close on 
completion' inRequest options, a 
request may run simply by double 
clicking on it on the desktop or 
from Windows Explorer.

Data Transfer Properties
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The Startup options control how a transfer request will be run if started from a shortcut, Start command, or Windows Explorer.  The startup options have no effect when 
a transfer request is loaded from the File-Open menu in Data Transfer.

The main option controls if you want the transfer to run when the request is opened.  The secondary option allow you to control if the request closes upon completion.

If both options are selected, this is considered to be an auto-start or auto-run request.  With the set of policies that have been added, administrators can allow users to 

only run auto-start requests.  By doing this, users would not be able to change and perhaps corrupt their transfer requests. 

Notes: Data Transfer Startup Options
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Connection options allow control of available connectivity 
options for Data Transfer

Connection options

Through connection options the 
security and signon information 
of an iSeries (V4R4 and later) 
connection may be modified on 
a per-request basis.

Data Transfer Properties
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Signon information

In V5R1 is the option to specify signon options for the current transfer request.  The default option is to use the current setting of Operations Navigator.  The option to 
use the current Windows user and password, a specific user id, or to prompt every time may be chosen.  In V5R2, the option to use Kerberos was added.

Connection security

Data transferred between the PC and iSeries can be encrypted by using SSL.  The use of SSL can be controlled on a request by request basis for Data Transfer.  

The default for the use of SSL is to use the Operations Navigator configuration for the iSeries the transfer is running to.  This allows users to share transfer requests, 
and have SSL enabled based on how they have chosen to set the system settings on their PC.

Data Transfer also allows users to override the Operations Navigator default, and specifically set to run with SSL on or off.  Running Data Transfer using SSL will affect 
the performance of the transfer.

SSL must be properly installed and set up on the PC.  If it is not, the option will be disabled in the Data Transfer application.  Additionally, SSL is only available on 
V4R4 and later versions of OS/400.

Notes: Data Transfer Connection Options
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Conversion options

Conversion options allow for the enablement of special data 
conversions and for error logging

Data Transfer Properties

Conversion options include:
CCSID 65535 conversions - 
eliminates hex data problem
Checking for and logging 
untranslatable fields
Preserve tabs on upload
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CCSID 65535 data - The use of this support is not recommended, but is supplied as a last resort type of function.  If at all possible, the CCSID of the data on the 
iSeries should be changed to a 
valid, convertable CCSID.  In the cases where it is not possible to change the CCSID of the data, this option can be used to convert the data from the iSeries server job 
CCSID to the client CCSID.  This implementation assumes the server job CCSID and the CCSID of data in the file are the same.  If they are not, invalid data 
conversions may result.

Check for untranslatable fields - If this support is not selected, Data Transfer will only display a message if translation errors are detected.  If this support is selected, 
Data Transfer will count the number of row/column values that were untranslatable.  Additionally, if iSeries Access Detailed Tracing is active, Data Transfer will log a 
message containing the row/column values that could not be converted correctly.  Performance will be affected when running with this option enabled.

Preserve tabs - If this support is enabled, Data Transfer will not convert tab characters to spaces when uploading data to the iSeries.  The default behavior is to convert 
tabs to spaces. 

Notes: Data Transfer Conversion Properties
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Where are the rest of my libraries? 
Browsing your libraries

The Answer:

They must be added 
to your library list!

Data Transfer Properties
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Working with the library list

The Data Transfer library list allows you to add your own 
library list to the library list of the current server job

Data Transfer Properties

System libraries are the default 
libraries in the server job library list
User libraries may be added so 
they are visible in the iSeries file 
browse window of Data Transfer
User libraries allow file transfers to 
occur by specifying only the file 
name

IBM eServer iSeries
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The library list page allows users to add libraries to the library list of the iSeries database server job supporting the current transfer request.  Doing this allows users to 
Browse these libraries or to use only file names in the transfer request.

"User" libraries can be added to the beginning of or at the end of the system library list of the current job.  The libraries that are added will be saved along with the 
transfer request will be used when the transfer request is opened again.

NOTE:  Using this function will not change the library list associated with the user profile.  Changes will only be made to library list of the iSeries database server job 
servicing the current Data Transfer request.

Notes: Data Transfer Library List
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Data Format Options - Date/Time and Decimals
Data Transfer From iSeries
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Data Format Options - Misc options
Specify a 
different 

language to 
sort by

Choose a 
sort 

sequence

Data Transfer From iSeries
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Data format options such as date and time format and separator can be set to format date and time fields transferred from the iSeries.  Other options include changing 
the decimal separator, and the sort sequence.

Data Transfer on-line help contains a listing of user defined language IDs. 

Notes: Data Transfer Data Format Options
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Data Transfer From iSeries Output Devices

Where, oh where can my data go?
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Selecting the output device

 

Data Transfer From 
iSeries may output to:

The display window
An HTML file
A printer
A PC file

Data Transfer Output Devices
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Output devices - Download to Display Details

By selecting the Display 
device and clicking on details, 
the Display Details window is 
displayed.

When downloading to a 
display window the font used 
to display the data may be 
changed to any one of the  
compatible fonts installed on 
the PC.

Data Transfer From iSeries
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Data Transfer allows users to select the font they want the data to be displayed in when downloading to display.  The selected font can also be saved in the transfer 
request file for future use.  

If a font is not selected, Data Transfer will use its default font for displaying the data.

Notes: Configurable Fonts for Download to Display
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Results of download to display

 

Right click on the 
display window to 
display a context 

menu.  The 
context menu has 

options for 
exporting display 

data to the 
clipboard. 

Data Transfer From iSeries
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Also, don't forget the download to display window has the ability to sort your data for you.  To do this, click on the column heading of the column you want to sort.  This 
will sort in ascending order.   If you want sort in descending order, click on the column heading again and the data will be sorted in descending order.

Another item available from the display window is the ability to copy 
data to the clipboard.  To do this, select a row or rows by clicking on the data in the first column.  Next, click the right mouse button on a selected item.  You can now 
copy the selected data to the clipboard.

Notes: Data Transfer to Display
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Output File Device details

 

1. Select whether to create new or to 
overwrite or append to an existing file.

2. Select the PC file type.
3. Certain file types have additional 

configuration options.  Select Details 
to configure those options.

4. Select to translate from the host 
CCSID to either ANSI or ASCII 
characters.

5. Select whether or not to save a File 
Description File  (FDF) for the PC file.  
An FDF is required to transfer the data 
to the iSeries

1

2 3
4

5

Data Transfer From iSeries
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Data Transfer has the ability to append data to an existing PC file.  This option is only available for the following file types: ASCII text, CSV, No Conversion, and Tab 
Delimited Text.

Data Transfer also has the ability to create a new PC file or to overwrite existing PC files.  When using create or overwrite, the following file types are supported: ASCII 
text, BASIC Random, BASIC Sequential, BIFF3, BIFF4, BIFF5, BIFF7, BIFF8, Comma Separated Variable (CSV), DIF, DOS Random, DOS Random Type 2, No 
Conversion, Tab Delimited Text, and Lotus WK4, 123, and 123 Version 9.

Notes: Data Transfer to PC File Details
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Lotus WK4, 123, and BIFF file type options

The Lotus WK4, 123, and 
BIFF5, 7, & 8 (Excel) file 
types in Express contain 
options to create extra 
workbook sheets when the 
first sheet overflows, to 
include column headings, and 
to place those headings on 
extra sheets.  Since the these 
file types support a limited 
number of rows per sheet, 
extra sheet support is very 
useful for large transfers.

Data Transfer From iSeries
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In the iSeries Access for Windows product, Data Transfer supports Lotus .123, Lotus .WK4 and Excel version 5 to version 8 files.  Configuration options have been 
added for these file types to improve their usefulness.

Lotus 123 and WK4 files only support 8192 rows per sheet.  Excel version 5 and version 7 files support 16,385 rows per sheet and version 8 supports 65,536 rows per 
sheet.  Due to this restriction, Data Transfer has options to allow for more data to be written to these files.

The option to control this is a checkbox for "Create extra sheets when first sheet overflows".  With this on, for example, if more than 8192 are being transferred from the 
iSeries to a WK4 file, Data Transfer will create additional sheets until all of the data has been written to the file.  (This is limited by the maximum number of 256 sheets 
supported by Lotus and Excel files.)

The other options control if column headings are included on any of the sheets, and if column headings are included on sheets 2 through n.

Notes: Data Transfer - Support for worksheets
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The tab delimited text file type 
stores data as a flat text file 
containing field data separated 
by tabs.  An example record 
may look like:

123 <tab> John Doe <tab> 10.1

The tab delimited file type
Data Transfer File Types
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In the Client Access Express product, Data Transfer has support for transferring to and from tab-delimited text files.

A tab-delimited text file is a file where the fields are separated by tabs, with each line ending combination of carriage return/line feed.

Notes: Support for Tab-delimited Text Files
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The ASCII file type in 
allows for 
configurable 
truncation of spaces 
from the end of 
records, padding of 
numeric fields with 
zeros and an option 
to include an end of 
file indicator

ASCII File Details
Data Transfer From iSeries
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Truncate spaces from end of records

The addition of this option allows users to control if spaces at the end of a row are truncated or left as part of the data.  In previous versions of Data Transfer, the trailing 
spaces were always truncated from the end of the row.

Pad numeric fields with leading zeros

This option allows users to choose whether or not to pad a numeric field with zeros if the length of the number is less than the maximum length of the field.

Include end of file indicator

This option allows users to choose whether or not to include the standard DOS ASCII end of file character at the end of the file.

Notes: ASCII Text File Details
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Data Transfer to HTML

Data Transfer 
supports downloading 
iSeries data into an 
HTML file.  The HTML 
file may be published 
on web server

Data Transfer From iSeries
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Data Transfer supports downloading data into a HTML table format.  To download into a HTML table, select HTML as the PC Output device on the Data Transfer From 
iSeries window.  

The HTML tags written by Data Transfer are compliant with the Version 3.2 HTML specification.  This means the browser used to read the HTML files must be 
compliant with the 3.2 specification.  Most newer browsers are 3.2 compliant.

There are several property pages in Data Transfer to allow for configuration of how the HTML tables are constructed.  These options are available by selecting the 
Details button next to the PC Output device item.  The first two property pages will be discussed here.

There is currently no upload support for HTML tables.

Notes: Data Transfer to a HTML table

IBM eServer iSeries
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HTML - File options

File options include:
Autosizing - automatically 
create multiple linked HTML 
files on large downloads
Prompting - turn off prompting if 
HTML file exists
Translation - set the character 
set used in the HTML 
document

Data Transfer From iSeries
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Use auto sizing - This option is necessary if you are downloading large files.  Many browsers do not support large HTML tables, and will "trap" or "die" when reading 
them.  When using this option, Data Transfer will automatically break the data into separate HTML tables at a specified size in kilobytes.  The default is 128 Kb.

Translation and charset - This allows you to select to translate to ANSI (Windows format), ASCII or UTF-8.  Also, based on the CCSID of your PC, it will control the 
charset tag that is written to the HTML file.  UTF-8 support allows data from multiple character sets to be displayed on the same HTML page.  For example, data in 
French, English, and Japanese may be contained within a UTF-8 document.  If you have the appropriate font, your browser will display this mixed data appropriately.

Notes: HTML Table Configuration - File options
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HTML - Document options

Document options include:
Title - Add a title to the document
Date/Time - Include the date and time 
on the document in a set position 
within the document.  The data and 
time format is the format set in the 
locale of the PC.

Data Transfer From iSeries
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The Document page allows you to set a title in your HTML file.  It also allows you to include a date and time the transfer was run and where this date and time is 
positioned when displayed.

Notes: HTML Table Configuration - Document 
options

IBM eServer iSeries
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HTML File produced by Data Transfer
Data Transfer From iSeries
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This screen shows Netscape Navigator displaying the result of a download of the file QIWS/QCUSTCDT into a HTML table. 

The table caption and titles were configured in the HTML settings pages.

Notes: Data Transfer to HTML
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Printer device options

Data Transfer supports 
transferring data directly to 
your printer.  Settings include 
setting print headings to 
appear on tops of pages, CPI, 
LPI, and the truncation of data 
on pages if the row size is too 
large for the page.

Data Transfer From iSeries
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Data Transfer has the ability to transfer data to your PC printer.  Options such as where to include headings, number of characters per line, lines per page, and whether 
or not to truncate extra data can be modified.  When transferring data to the printer the standard Windows dialog will be displayed to allow printer selection to occur.

Notes: Data Transfer to Printer
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How do I get data to my iSeries?
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Use Data Transfer To iSeries to create new transfer request 
files and to transfer data from the PC.

The Data Transfer To iSeries main panel

1.Enter or select the name of 
the PC file to transfer data 
from.

2.Select the iSeries system 
name to transfer data to.

3.Select the 
Library/File(Member) to 
transfer data to on the 
iSeries.

4.Select additional upload 
options.

5.Transfer data to your 
iSeries.

1

2
3

4
5

Data Transfer To iSeries
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1) Start by selecting the PC data file you want to send to the iSeries.  A Browse function is provided to allow you to locate the data file.

2) Select a system name from the system list.

3) Either enter the library/file you want to transfer the PC data into, or select "Browse" to find the library/file you want to transfer into.  

4) Select the Details button to provide additional required information.

WARNING:  When transferring data into an existing iSeries file, if the replace member options is chosen (the default), the member's contents are deleted and replaced 
with the data contained in the PC data file.

Notes: Steps to perform a simple upload of a file
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iSeries File Details - upload options

Source Physical files
Select not to use an FDF file
Select the proper file type
Select the record length, file 
and member text and 
authority on create

Data Physical files
Use a PC FDF file
Select Field Reference File, 
file and member text, and 
authority when creating new 
files

Data Transfer To iSeries
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Description of what each control does/controls:

Use PC file description - This option should be selected if you are sending PC data to a data physical file.  If you are sending PC data to a source physical file, this 
should not be selected, and you must select the PC data file type from the File type list.

File name - This file is a FDF file that contains the description of the data contained in the PC data file.  This file is needed in order to have the Data Transfer application 
correctly read and format the PC data before sending it to the iSeries database file.  A FDF file is created by default when a Data Transfer From iSeries request is run.  
Data Transfer will not send data correctly if this FDF file does not match the data in the PC data file.

File type - This option describes what PC file format is contained in the PC data file.  This is only selectable when you are not using a FDF file to describe the data in 
the PC data file.

Notes: Understanding the iSeries File Details Panel
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Translate from - This allows users to state if the data contained in the PC data file is stored as ANSI (Windows format), ASCII (DOS format) or another CCSID.  This 
option must match the option used when performing the Data Transfer From iSeries, and controls what is done for PC to iSeries (EBCDIC) character conversions.

Create iSeries object - Allows users to create a new database file and member, create a new member for an existing database file, replace the data in an existing 
member of a database file, or  append to an existing database member.

Member text - Comment text to be associated with the new member being created. 

File text - Comment text to be associated with the new file being created.

Notes: Understanding the iSeries File Details Panel 
(cont)
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iSeries file type -  Data or Source.  Data means you are transferring to a data physical file.  If Data is specified, a PC file description file must be used.  This description 
file must match the definition of the iSeries data physical file format.  Also, if you are creating a new file, you must provide the name of an existing iSeries database file 
you want to have the new file based on.  A "new" data format cannot be created using Data Transfer (without the help of the Create iSeries Database File tool).

Source means you are transferring to a source physical file.  If Source is specified, a PC file description should not be used, and you must specify a File type for the 
PC file.  When using the Source option and creating a new file, a record length must also be specified.  This record length should be the length of the longest record 
you want to send to the iSeries + 12.  The 12 additional characters are reserved for the initial columns of a source physical file.

If you want to transfer to a "flat file" where you only have 1 unformatted character field, you must use the Data option and use a PC file description (FDF) file.

Notes: Understanding the iSeries File Details Panel 
(cont)
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Using the Create iSeries Database File Wizard
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Starting the wizard

Start the 
Create iSeries 
Database File 

tool by 
selecting it 

from the Tools 
menu or by 

clicking on its 
icon in the 

toolbar

Create iSeries Database File Wizard
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In iSeries Access for Windows, Data Transfer has the ability to define and create a new iSeries database file based on an existing PC data file. The new file is created 
as an SQL table.  In previous releases, Data Transfer was only able to create files based on existing iSeries database files.  The new function will also create the FDF 
file required for uploading the data to the new file.

The interface to create a new database file is found in the Data Transfer to iSeries application.  The function can be started from the Tools menu or a new toolbar icon.

The image shown on the previous page is the welcome page of the Create Database File wizard.

Notes: Create Database File Wizard
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Selecting the PC file that contains your data

The PC File Name 
panel allows you to 
enter or browse for 
the name of your 
PC file that you 
wish to use as a 

model for the new 
file on the iSeries

Create iSeries Database File Wizard
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The first step in creating a new iSeries database file is to specify the PC file that you want the file based on.  The file can be in any of the following formats:

ASCII text, BASIC Sequential, BIFF3, BIFF4, BIFF5, BIFF7, BIFF8, CSV, DIF, Tab-delimited text, WK4, or 123.

If you pick a file type containing detailed type information, such as BIFF or WK4, Data Transfer is able to more accurately determine the definition of the iSeries file you 
will want to create.

Notes: Create Database File Wizard
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Selecting the PC File Type

The File Type page 
allows you to select 
the type of the PC file 
that you specified on 
the previous panel.  
The wizard will try to 
determine the file type 
based on the 
extension of the file 

Create iSeries Database File Wizard
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After specifying your PC file, Data Transfer attempts to determine the type of the file.  The type detected by Data Transfer is shown in the window.  If this "guess" by 
Data Transfer is not correct, you will need to set the correct file type before you continue.  If this is not done, Data Transfer will not be able to read the data file 
correctly, and an error will be displayed or your file will not be scanned correctly. 

Notes: Create Database File Wizard
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The File Description File panel

To transfer data to your 
new file on the iSeries, an 
FDF file must be 
generated to match your 
PC file.

Create iSeries Database File Wizard
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The information you enter along the way in the wizard will be loaded into the Data Transfer to iSeries application upon completion of the wizard function.  

The FDF file is an essential item for step of transferring the data to the iSeries.  This panel allows you to set the name of the FDF file to be used for the transfer.  

Notes: Create Database File Wizard
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The Scan PC File panel

The Scan PC File 
panel is used to 

scan your PC file to 
determine its 
field/field type 

layout

Create iSeries Database File Wizard
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In order to retrieve the field information from the PC data file, Data Transfer must "scan" or parse the data.  If you chose not to do this, you will be required to manually 
set up the field definitions from scratch.  If you run the scan operation, Data Transfer will scan the PC file and come up with a first pass at what the field definitions of 
the new database file will need to be to hold the data from the PC data file.

Notes: Create Database File Wizard
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The Contents of PC File panel

The Scan operation 
in the previous panel 
builds a list of fields.  

These fields are 
displayed in the 

Contents of PC File 
panel.  Fields may 

be modified by 
selecting them and 
clicking on 'Details'

Create iSeries Database File Wizard
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If you chose to have Data Transfer scan the PC data file, you will be presented with a list of fields found in the PC data file.  If you chose a simple file type such as 
ASCII text, the field definitions will almost always need to be modified.  If you chose a more complex file type such as BIFF or WK4, only minor modifications may be 
needed.  Either way, it is a good idea to verify the field definitions are going to allow for all possible values you will want to insert into the iSeries database.

A context menu (right click in Details list control) is available to allow users to add to or remove fields from the list.

Notes: Create Database File Wizard
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The System Name panel

Select or type 
in the name of 

the iSeries 
where you 

want to create 
a new file

Create iSeries Database File wizard
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On this panel you need to specify the iSeries system name you want to create the database file on.

Notes: Create Database File Wizard
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The iSeries File and Library panel

Enter the 
Library/File name 

you wish to create.  
A member name 

may not be 
specified since this 

tool uses the 
iSeries SQL Create 

TABLE interface

Create iSeries Database File Wizard
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Now you must specify the library name and file name of the file you want to create.  The syntax of this name is library/file.

After you have entered this, the next panel will allow you to specify a text string for a description of the file.

Lastly, you will be shown a confirmation panel containing the information gathered throughout the wizard.  Selecting Next from this confirmation panel will create the 
database file.

Notes: Create Database File Wizard
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The final panel - your file has been created!

Select finish to 
return to Data 
Transfer To 

iSeries.  
Remember - 
your file has 

been created, 
but has no data!

Create iSeries Database File Wizard
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After the successful creation of the new database file, you will be presented with a informational panel stating the new file was created.

Notes: Create Database File Wizard
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The PC file we 
used as a model

The iSeries System 
we created the file 

upon

The Library/File 
name of our new 

file

Returning to Data Transfer To iSeries

Click to transfer 
data to your new 

file

Create iSeries Database File Wizard
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After the file has been created, you return to the Data Transfer to iSeries window.  At this point, the database file has been created, and the Data Transfer window 
values have been set to the values enterred in the wizard.  No data from the PC data file have been sent to the iSeries.

To complete the transfer, you must now select the  "Transfer data to iSeries" button.

Notes: Create Database File Wizard
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Batch Data Transfers
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RTOPCB [/S] [[/I] [filename [/C] [...] ] | [[I] /F list file] ]
  /S        Show transfer statistics.
  filename An iSeries to PC transfer request (.TTO or .DTF),
                Rumba (.RTO), or Windows 3.1 (.DT) file transfer
              request.
  /C          Process next file independent of previous file.
  /I          Ignore warnings.
  /F         Process files within list file (one filename per line).
  list file A file containing a list of transfer files to process.

Examples:
  RTOPCB c:\temp\test.tto
  RTOPCB /S c:\temp\test.tto /C c:\temp\trans.dtf
  RTOPCB /S /F c:\temp\transfer

Batch transfer command interface
Data Transfer From iSeries

IBM eServer iSeries
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In the past, Data Transfer only supported one transfer request per invocation of RTOPCB.  Now, Data Transfer supports multiple transfer requests per invocation of 
RTOPCB.

The main reason for this interface addition is performance.  Assuming your transfer requests run to the same iSeries, by running multiple requests per invocation of 
RTOPCB your performance can be substantially improved.  

Users will save the performance costs of:
 ( # of requests - 1) * (connection time + disconnect time)

By doing this the speed of the transfers will be improved and the load on the iSeries will also be reduced since one job will now service multiple transfer requests.

Notes: RTOPCB (Data Transfer in Batch)
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Batch transfer command interface

RFROMPCB [/S]  [[/I]  [filename [/C] [...] ] | [/I] [/F list file] ]
  /S         Show transfer statistics.
  filename A PC to iSeries file transfer request (.TFR or .DTT),
             Rumba (.RTO), or Windows 3.1 (.DT) file transfer          
                 request.
  /C         Process next file independent of previous
             file.
  /F         Process files within list file (one filename per line).
  list file  A file containing a list of transfer files to process.

Examples:
  RFROMPCB c:\temp\test.tfr
  RFROMPCB /S c:\temp\test.tfr /C c:\temp\trans.dtt
  RFROMPCB /S /F c:\temp\transfer

Data Transfer To iSeries
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In the past, Data Transfer only supported one transfer request per invocation of RFROMPCB.  Now, Data Transfer supports multiple transfer requests per invocation of 
RFROMPCB.

The main reason for this interface addition is performance.  Assuming your transfer requests run to the same iSeries, by running multiple requests per invocation of 
RFROMPCB your performance can be substantially improved.  

Users will save the performance costs of:
 ( # of requests - 1) * (connection time + disconnect time)

By doing this the speed of the transfers will be improved and the load on the iSeries will also be reduced since one job will now service multiple transfer requests.

Notes: RFROMPCB (Data Transfer in Batch mode)
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Scheduling Batch Transfers

RTOPCB is 
scheduled to 
run at a given 

date and 
time

Automating Data Transfer
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iSeries Access for Windows does not provide a scheduler program.  For an example of how to schedule a Data Transfer request, we picked Microsoft's System Agent 
application.

From Microsoft Task Scheduler select Add Scheduled Task.  Go through the wizard to create the scheduled task and enter 

"C:\Program Files\IBM\Client Access\RTOPCB.EXE" your.TTO

for the task to execute.

Complete the other scheduling options offered by the System Agent application.  You are now ready to run transfer requests on a scheduled basis.

Notes: Scheduling a Data Transfer Request
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Using the Excel Add-In
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Installing the Add-In

 

To install the Add-In 
for Excel (if it wasn't 

automatically 
installed), select 

Tools -> Add-Ins... 
and locate 

cwbtfxla.xll under 
the Client Access 

'shared' folder.

Using the Excel Add-In
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Data Transfer supports transferring data directly to and from a Microsoft Excel sheet.  This support is currently available withMicrosoft Excel 97, Excel 2000, and Excel 
XP.

This support is accessible by clicking on the Data Transfer upload or download button on the Excel toolbar.

NOTE:  The Data Transfer Add-in is longer supported for Excel 95.

Notes: Data Transfer Add-in for Excel
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If Microsoft Excel was installed on your PC before iSeries Access, the iSeries Access setup program will automatically install the Microsoft Excel add-in when you 
choose to install Data Transfer.

If Microsoft Excel was installed on your PC after Client Access, you
will have to manually add the Data Transfer Add-In with these steps:

1 Open Microsoft Excel.
2 Click Add-Ins from the Tools menu.
3 Click the Browse... button.
4 Locate the path in which you installed Client Access.
5 Double click on the folder named 'Shared'.
6 Double click on the cwbtfxla file.
7 Click the OK button.

Data Transfer Add-In support is available for Excel 97, 2000, and XP.

Notes: What do I do if the Data Transfer options are 
not available in Excel?
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Transferring data into Excel

To transfer data from 
your iSeries to or 
from Excel select Data 
-> Transfer Data 
From/To iSeries from 
the Excel menu or 
click on one of the 
Data Transfer icons 
on the toolbar.  

Using the Excel Add-In
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Data Transfer download support into a Microsoft Excel sheet is accessible from the Excel menu.  Go to the Data menu and select Transfer Data from iSeries. 

Data Transfer download support is also available from the Client Access toolbar.  The icon for Data Transfer resembles two small tables or a notebook.

Data Transfer upload support is available in iSeries Access for Windows! Data from an Excel sheet may be uploaded directly to the iSeries from Microsoft Excel.

Notes: Data Transfer to and from Excel
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The Transfer Request panel

The Transfer 
Request panel 

allows you to create 
a new transfer 

request or to using 
an existing one to 

populate the 
spreadsheet

Using the Excel Add-In to transfer data from the iSeries
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After selecting the Data Transfer from iSeries icon on the Excel toolbar icon or the Transfer Data from iSeries menu item, a Transfer Request window will be displayed.

This window allows you to select an existing transfer request to run, or
to create a new request by walking you through a series of wizard pages.

The window also has a setting for controlling where the data will be placed within the Excel sheet.  A final setting lets you control whether or not column headings are 
included in the sheet.

Notes: Data Transfer From iSeries into Microsoft 
Excel
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Using a transfer request file

Transfers may be 
made directly into an 

Excel sheet by 
opening a saved 

transfer request on 
the PC

Using the Excel Add-In to Transfer Data from the 
iSeries
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If you choose to use an existing transfer request, you can click on the Browse button and search for requests.  The default for the Browse is to search for .DTF files.  
You may also search for .TTO, .DT, and .RTO files.

If you know the path and name of the request you want to run, an edit box is provided for you to enter the name without doing the Browse. 

Notes: Data Transfer From iSeries into Excel using 
existing Transfer Requests
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A completed transfer into Excel

A completed 
transfer into Excel, 

complete with 
column headings 
and data from the 

iSeries file

Using the Excel Add-In
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This example shows the results of a SELECT * from QIWS/QCUSTCDT
into an Excel sheet at Column A, Row 1.  The option to "Include column headings" was selected in this example.

Notes: Downloading data into Excel
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Data can now be 
uploaded directly 

from an Excel 
spreadsheet to 
the iSeries!  A 

menu option and 
Toolbar button are 
available for this 

function 

Uploading data from Excel
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In V5R1 of Client Access Express the option to upload data has been added to the Add-in for Excel.  This new option can be accessed either via the toolbar or the 
Excel Data menu.  This option is also available in iSeries Access for Windows.

This new support allows the following functions for transferring data to the iSeries:

Create new file and member based on iSeries file
Create new file and member based on spreadsheet
Create new member
Replace member
Append to existing member

The second option, 'Create new file and member based on spreadsheet' is the most immediately useful.  It allows users to create a new database file on the iSeries 
based on the contents of the spreadsheet.  Data is then uploaded to the new table.

Notes: Uploading data from Excel
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Highlight the 
range of 
cells to 
upload

Step 1 - Selecting the data to upload
Uploading data from Excel
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Select the 
toolbar 
button or 
menu item to 
active the 
Add-in 

Step 2 - Activating the Add-in
Uploading data from Excel
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Select 'First row 
is column 
headings' if that 
is true
Verify the correct 
range is specified 
for upload
Choose to create 
a new transfer 
request

Step 3 - The main upload panel
Uploading data from Excel
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A wizard is available 
to help create a new 
transfer request.  
This request may be 
stored and re-used 
by the Add-in to 
upload the same or 
updated spreadsheet 
data at a later time. 

Step 4 - The request wizard
Uploading data from Excel
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Select an option to store 
your data on the iSeries

If you don't currently 
have a file to store the 
data and do not have a 
reference file (a file on 
the iSeries that matches 
your PC data) choose 
'Create new file and 
member based on 
spreadsheet'

Step 5 - Data storage options
Uploading data from Excel
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Upload support for the Add-in has many options for storing your data on the iSeries.  Which option you choose will be based on whether you want to create a new file 
on the iSeries, create a new member, replace the data in a member, or append additional data to a member.

Create new file and member based on iSeries file
This option allows you upload data to a new file. The file will be created based on an existing file on the iSeries.  The new file will have the same format as the existing 
file.  The range of cells selected in the spreadsheet must have the same format of data as the file on the iSeries for the upload to be successful.

Create new file and member based on spreadsheet
This option allows you to upload data to a new file.  The file will be created based on the format of the cells selected in the spreadsheet.  Wizard pages help to 
generate a File Description File and a new file on the iSeries.

Create new member
This option allows you to create a new member for an existing file on the iSeries.  The spreadsheet data is then uploaded to this new member.

Replace member
This option removes the data from an existing member and replaces it with data from the spreadsheet.

Append to existing member
This option appends spreadsheet data to the end of an existing member

Notes: Data Storage Options
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Uploading data to the 
iSeries with Data 
Transfer requires a File 
Description File.  
Specify the name of the 
File Description File to 
use.  If you do not have 
a File Description File 
that matches your data, 
specify the name of a 
file to create.

Step 6 - Creating a file description file
Uploading data from Excel
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If you do not have a 
File Description file 
to match your data 
the wizard will 
create one for you

Step 6 (continued) - Creating an FDF
Uploading data from Excel
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To create a new iSeries 
file based on the 
spreadsheet data, the 
spreadsheet must be 
scanned to determine its 
data format

Select 'Start scan' to 
scan the spreadsheet

Step 7 - Scanning the spreadsheet
Uploading data from Excel
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After scanning the data, 
review the list of fields 
found in the 
spreadsheet.  If a 
column requires 
modification, select it and 
click 'Details'. 

Step 8 (continued) - Spreadsheet columns
Uploading data from Excel
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By clicking 'Details' you 
may add a field 
description, change the 
data type, and modify 
various other field 
attributes.

Note: Incorrect 
modification of a field 
may result in a field that 
does not match the data 
in your spreadsheet! 

Step 8 (continued) - Spreadsheet columns
Uploading data from Excel
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Specify a system name
Customize properties 
such as Date/Time 
format, CCSID 65535 
conversion, and signon 
options
Specify the library/file 
to create

Steps 9,10,& 11 - System, Customize, & File
Uploading data from Excel
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Specify a file 
description
Confirm the Library/File 
and FDF to use or 
create
Save the upload 
request to a request 
file and upload the 
spreadsheet data 

Steps 12,13,& 14 - File text, confirm, & save
Uploading data from Excel
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What's new?
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Option to upload directly from Excel to the iSeries via the Add-In

Configurable signon information when connecting to the iSeries.  This option is 
available on a per-request basis.

Support for the Lotus 123 version 97 and Version 9 file types

Support for the Microsoft Excel version 8.0 (BIFF8) file type.  This type is used by 
Excel 97 and 2000.

Support for 4 byte (float) and 8 byte (double) floating point data types.

Support for the BIGINT data type.  This data type is available in release V4R5 of 
OS/400.

UTF-8 Character support for download to HTML

ActiveX Automation objects to programmatically run data transfer through various 
programming interfaces including Visual Basic for Applications (used to write MS 
Office macros), Visual Basic, C++, Java, and other platforms that support ActiveX.

New in Data Transfer
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What are my other data access options?
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ODBC/JDBC

ADO/OLE DB Provider

DB API

iSeries Navigator - Database

Java Toolbox

iSeries Access for Web

More Client Database Options
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References

Additional Documentation & Information
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iSeries Access for Windows Web Site - 
http://www.ibm.com/servers/eserver/iseries/access/

Technical Studio 
Information APARs

iSeries Access for Windows User's Guide
Found in iSeries Access for Windows folder 

Client Access Express for Windows Redbook
SG24-5191-00
http://www.redbooks.ibm.com

More information...
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This publication may refer to products that are not currently available in your 
country.

IBM makes no commitment to make available any products referred to herein.

Notice
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Microsoft and Windows NT are registered trademarks of Microsoft Corporation in the United States, other countries, or both. 
Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.
SET and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC. 
C-bus is a trademark of Corollary, Inc. in the United States, other countries, or both.  
UNIX is a registered trademark of The Open Group in the United States and other countries.
Other company, product or service names may be trademarks or service marks of others. 

Information is provided "AS IS" without warranty of any kind.

All customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved.  Actual environmental costs and 
performance characteristics may vary by customer.

Information in this presentation concerning non-IBM products was obtained from a supplier of these products, published announcement material, or other publicly available sources and does not 
constitute an endorsement of such products by IBM.  Sources for non-IBM list prices and performance numbers are taken from publicly available information, including vendor announcements and 
vendor worldwide homepages.  IBM has not tested these products and cannot confirm the accuracy of performance, capability, or any other claims related to non-IBM products.  Questions on the 
capability of non-IBM products should be addressed to the supplier of those products.

All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only.  Contact your local IBM office or IBM authorized 
reseller for the full text of the specific Statement of Direction.

Some information in this presentation addresses anticipated future capabilities.  Such information is not intended as a definitive statement of a commitment to specific levels of performance, function 
or delivery schedules with respect to any future products.  Such commitments are only made in IBM product announcements.  The information is presented here to communicate IBM's current 
investment and development activities as a good faith effort to help with our customers' future planning. 

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment.  The actual throughput or performance that any user will experience will vary 
depending upon considerations such as the amount of multiprogramming in the user's job stream, the I/O configuration, the storage configuration, and the workload processed.  Therefore, no 
assurance can be given that an individual user will achieve throughput or performance improvements equivalent to the ratios stated here.

Photographs shown are of engineering prototypes.  Changes may be incorporated in production models.
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